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Cameras

NIHTS: Spectrographic channel, Rockwell Hawaii-1 array

XCAM: Slit Viewing/Acquisition Camera, Xenics XEVA IR camera

LMI: Large Monolithic Imager (Visible)

Fun Facts

NIHTS XCAM LMI (binned 2×2)

Gain 24 e-/ADU 2.89 e-/ADU
Read noise 100 e- ∼6 e-
Readout Time 0.001504 sec (Row Time) 24 sec
Minimum Exp. Time 0.77 sec 0.1 sec
Maximum Exp. Time 5 sec
Detector Size 1024×1024 320×256 1564×1540
Pixel Scale 0.13 arcsec/pixel 0.326 arcsec/pixel 0.24 arcsec/pixel
Slit Widths (′′) 4.03, 1.61, 1.34, 1.07,

0.81, 0.54, 0.26
Field of View 12′′ spatial length 60′′ × 90′′ 4′ × 6′

0◦ Field Orientation N:right, E:up N:up, E:left
Dichroic Transmission 0.4 - 0.7 µm
Operating Temperature 75 K 201 K 153 K

A0 and G2 Standard Stars:

http://irtfweb.ifa.hawaii.edu/cgi-bin/spex/find_a0v.cgi

Closure Limits

Humidity: ambient ≥ 85%, M1 ≥ 80%
Wind: sustained ≥ 11m/s, gusts ≥ 16m/s
Temperature: > 30◦C or < −20◦C
Precipitation/Dust/Smoke: Any form, but Telescope Operator’s judgment call

Data Directories

NIHTS: dct-obs1.lowell.edu:/nihts/YYYYMMDDa (or b or c ...)

XCAM: xcam.lowell.edu:/Users/user/xcam/xenics-data/YYYY-MM-DD

LMI: dct-obs1.lowell.edu:/LMI/YYYYMMDDa (or b or c ...)
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Quick Start

1. Setup (§2):

(a) Start up LOIS and the NIHTS LOUI on dct-obs1 (or dct-obs2).

(b) Set Observer and Path Information.

(c) Start up NIHTS/ZTV through the Mac Mini screen share.

(d) Take nihts test image.

(e) Move the dichroic in place.

2. Calibrations (§3):

(a) Arcs.

(b) Dome Darks and Dome Flats.

3. Observing (§4):

(a) Telescope operator performs Wavefront.

(b) Focus Sequence.

(c) Target Acquisition.

i. Create a difference image of the target.

Click to Home in ZTV.

ii. Declare Target is at Home.

iii. Move to Slit Position.

iv. Nudge with small offsets to refine pointing in ZTV if needed.

v. Perform Nod Sequence.

vi. Clear Offsets in ZTV.

(d) Real Time Analysis in LOUI:

i. Pixel Dump

• p = pixel dump

ii. Line Profile

• Type l = display line and column plots for the part of the image displayed in
the LOUI image display.

• Type L = display line and column plots of the entire image, regardless of what
portion is actually displayed.

iii. LINE CUT

• Horizontal Spectrum

• Vertical Spectrum

4. Shut Down (§5):

(a) dct-obs1 (or dct-obs2)

i. Do NOT [Exit LOIS], simply click the red [X] in the upper left to close the LOUI.

ii. Do NOT close the obsnihts@nihts terminal window.

(b) Mac Mini Screen Share

i. Exit ZTV and NIHTS.

ii. In the white “PWR USB” terminal window type: python NIHTS_shutdown.py

iii. Close screen sharing window.
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1 Introduction to NIHTS

The Near-Infrared High-Throughput Spectrograph (NIHTS, pronounced “nights”) is a low-resolution
(R∼200) near-infrared prism spectrograph, covering 0.86-2.4 microns in a single order. NIHTS
achieved first light in November 2015. NIHTS contains no moving parts and employs a single
slit mask with 7 different slit widths (4.03, 1.34, 0.81, 0.27, 0.54, 1.07 and 1.61 arcseconds), each
approximately 12 arcseconds in length. During early commissioning NIHTS was fed by a fold mir-
ror in the instrument cube, which was replaced by a dichroic on 13 December 2017 to allow for
simultaneous LMI imaging and NIHTS spectroscopy. Current instrumentation plans have NIHTS
available on the telescope every night.

NIHTS commissioning continued through the 2018A semester with the instrument operating in
shared risk mode. The instrument has been available for normal science observing since 01 July
2018.

Software Systems

Presently there are four fundamental software systems of which the astronomer should be aware.
Each system runs on a different server, though the astronomer interfaces with them through the
standard observing computer, a dual-screen iMac named dct-obs1 (or dct-obs2).

• LOIS (Lowell Observatory Instrument System) is the guts-level system that actually runs
the CCD controller, setting the micro-code, generating the FITS header, and doing all the
heavy lifting. It runs on the computer nihts.

• xcam is a Mac Mini accessed through VNC screen sharing and is the primary interface
for controlling the NIHTS slit viewing camera and NIHTS spectral channel. There are two
primary interfaces on xcam: a GUI panel called NIHTS and a GUI panel called ZTV. Both
have corresponding terminal windows that display status information. The observer issues
commands through the NIHTS GUI to control exposures on the slit viewing camera and the
NIHTS spectral channel (e.g. defining the type of exposure, exposure time, setting the desired
slit). The ZTV GUI is an astronomical image viewer originally designed by Henry Roe that
has been adapted to display and analyze images from the NIHTS slit viewing camera.

• LOUI (Lowell Observatory User Interface) acts as a status summary system for the user. In
the case of NIHTS where ZTV is used for instrument control, we simply use the LOUI to
monitor instrument and telescope subsystem processes. You can see real time image display,
perform limited image analysis, and view the facility summary. However, different from other
DCT instruments, the NIHTS LOUI is generally not used to take exposures. It runs on
dct-obs1 (or dct-obs2).

• JOE (Java Operator Executive) is a software “controller” (and is also a server that runs the
activeMQ broker) that needs to be running. Generally the astronomer doesn’t have to worry
about this, other than to be aware that JOE needs to be alive for control of all of the moving
parts needed to take an exposure. Control of JOE is handled by the Telescope Operator at
the beginning of the night. The status of JOE is indicated in the bottom status bar of the
LOUI.
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2 Beginning of the Night

1. Starting Up LOUI:

(a) Log on to dct-obs1 (or dct-obs2) as observer. The password is on the whiteboard.

(b) Open the NIHTS LOUI by double clicking on the [LOUI NIHTS] icon on the desktop.

(c) LOIS is left running to monitor the instrument temperature. At the start of an observing
session, it is highly recommended the LOIS be re-started to avoid any possible lingering
side effects of earlier use.

(d) Kill LOIS by clicking on the red [EXIT LOIS] in the upper right corner of the NIHTS
LOUI (Figure 1). When the pop up appears, click okay to continue with the Kill LOIS.

Figure 1: The top menu bar allows
you to Initialize and Exit LOIS.
The top menu bar is located in the
top right of the NIHTS LOUI.

(e) You should see “LOIS Exiting Normally” in the LOIS log window in the lower left corner
of the LOUI (Figure 2). Wait 15 seconds for this process to complete.

Figure 2: The NIHTS console, lo-
cated in the bottom left of the
LOUI, populates with status in-
formation, including image expo-
sures, and errors.

(f) There should be a terminal window already open connected to nihts. If not, open one
and connect with ssh obsnihts@nihts using the password listed on the whiteboard.

(g) Type st to check the status of LOIS.

i. When status is “Not Running” type lois & to restart LOIS.

ii. If LOIS is still “Running”, try to exit LOIS again by clicking the red [EXIT LOIS].
If LOIS is still “Running”, perform a kill LOIS in the terminal window. Ask the
telescope operator how to do this.

iii. Note: NIHTS terminal window should always remain open - please do not close it.

(h) Click on the green [Initialize LOIS] in the upper right corner of the NIHTS LOUI shown
in Figure 1. A stream of messages will go by in the LOIS log window in the lower left
corner for about six seconds. Among the last half dozen messages or so, in orange, it
should say “LOIS Successfully Initialized”. You can ignore the red telemetry error.

(i) In the lower right of the LOUI (Figure 3), you will see the “Information View” exposure
time counter marked in blue (“exposure 1/1 - 0.0/0.0 seconds (100%)”). Within this
panel, scroll down until you can enter the Observer Name and Observer Affiliation
(Figure 4). Fill these out and click [Set Standard Image Path & Observer]. Note that if
you do not do a “Set Standard Image Path & Observer” at the start of your observations,
LOIS remembers the last entries and will use those. When you click [Set Standard Image
Path & Observer], this will create the data directory where the data will be stored; it
will have a name like 20170820a, where 20170820 corresponds to the UT date for that
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night. If you are the second (or third or...) observer for the night, first click the box
labeled [New Rundate Directory]. This will change the “a” to “b” or “c” or.....

(j) You can have sounds initiated at the end of a science exposure and/or at the end of the
read-out and/or at the end of a series of exposures. Open [Sound Effects] (Figure 5)
below the data path to change the sound feature. By default the LOUI is silent.

Figure 3: The info view is located
in the bottom right hand panel of
the NIHTS LOUI. Here, you can
view the exposure and sequence
status.

Figure 4: The observer informa-
tion is entered in the panel below
the Info View. This sets the path
and observer information for head-
ers.

Figure 5: Sound effects are avail-
able for exposure readout notifi-
cations at the bottom of the Info
View panel.

(k) Grab the tab that says [Facilities Summary] (Figure 6) in the upper left and pull it out
to somewhere on the desktop.

(l) All of the tabs can be individually pulled out and re-positioned on the desktop. If the
user makes a mistake and winds up with an unexpected window configuration, they
can reset everything to the default using the “Reset Perspective” option in the Window
menu.

Figure 6: The Facility Summary
contains all useful information re-
garding the telescope information.
This includes pointing, UT time,
target name, pointing, offsets, and
more.

(m) The LOUI provides some very valuable guidance to you as to whether or not the telescope
is ready. Note at the bottom of the LOUI screen (Figure 7) the words GDR, JOE, TCS,
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AOS, and DOME are color coded to indicate the status of those sub-systems. First,
check that JOE is on. If JOE is not on, ask your telescope operator how JOE is doing.

(n) Wait for TCS, AOS, and DOME to all turn green before starting a science exposure.
These indicate, respectively, that the telescope is in position, that the secondary mirror
is in position and the primary mirror supports are tweaked and stable, and that the
dome is in position. If you are using the guider, and the guider is currently guiding,
GDR will be green. (The AOS light may occasionally flicker; this is just due to the
secondary being adjusted for temperature and elevation changes; don’t worry about it.)

Figure 7: The Status Bar is lo-
cated across the bottom of the
NIHTS LOUI. Here, you can see
the status of TCS, AOS, the dome,
JOE, and the guider.

2. Starting Up xcam:

(a) Open a VNC connection to the Mac Mini.

i. From the Desktop on dct-obs1 (or dct-obs), type cmd-K to open the “Connect to
Server” window.

ii. Enter server address vnc://xcam.lowell.edu and click [Connect].

iii. Enter the username (xcam) and password listed on the whiteboard.

(b) Double click on the NIHTS desktop icon. This will open two terminal windows and two
GUI interfaces.

i. The terminal window in the lower left (white text, black background; Figure 8) is
labeled XCAM and is a status window for the NIHTS GUI interface.

ii. The terminal window in the upper right (black text, grey background; Figure 9) is
labeled ZTV and is a status window for the ZTV GUI interface.

iii. The NIHTS GUI (Tab 1; Figure 11) is where you will enter commands for both the
slit viewing and spectral cameras.

iv. Wait 30 seconds for the ZTV GUI to open (Figure 10).

(c) Select the [Auto-load file] radio button on the ZTV GUI under the default [Source] Tab
(Figure 10) to auto display the most current image from the slit viewing camera in the
display window.

(d) You will need to take a test image of the spectral channel which you will see displayed
in the NIHTS LOUI. Use the [Test Image] button in Tab 1 of the NIHTS GUI to take
your exposure.

(e) For the first exposure you should see a note about bad telemetry in the LOIS log window
of the LOUI and no image displayed in the viewer. Take another test image for the
display to appear. The data will now begin saving to the new directory. You may need
to click the [CURRENT] button in the NIHTS LOUI to see the display.

(f) IMPORTANT NOTE: If you start up a ZTV session before the UT date has switched
(5pm MST), you will need to redo the entire Mac Mini NIHTS Startup (starting at Step
2b above) when the UT date changes. This is a known bug that will eventually get fixed.
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Figure 8: XCAM Terminal Win-
dow

Figure 9: ZTV Status Terminal
Window

Figure 10: ZTV GUI: Source Tab

Figure 11: NIHTS GUI
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3 Calibration

Calibrations for NIHTS include arc line spectra from a Xenon lamp mounted inside the instrument
cube and dome flat field exposures. The dispersion solution is dependent on elevation angle. We see
up to ∼1 pixel shifts from zenith to the horizon (see Section 8.6). As a result, we require calibrations
at the beginning of the night, but also at each target pointing. Batch scripts are provided to collect
relevant calibration frames for all available slits. Setting up for and running these scripts takes
approximately 30 minutes and can be completed before twilight. On sky arcs calibrations will take
only approximately 2 minutes (see Section 4.5).

3.1 Xenon Arc Lamp

1. Ask the telescope operator to put the dichroic in place for NIHTS (nominal position: 237.9 mm).

2. The instrument cover should be closed at this time and the telescope should be pointed at
zenith.

3. In the Calibrations Tab of the NIHTS GUI (Tab 2; Figure 12), click the [ARCS LONG]
button to begin the Arc Lamps calibration sequence.

(a) This script will turn on the Xenon lamps and take 5 exposures at 120 seconds each and
3 exposures at 20 seconds each. There is no required warm-up time for the lamps. The
script will then turn the lamps off and take 1 exposure at 120 seconds and 1 exposure at
20 sec to capture the thermal background. A background subtracted arc line spectrum
is shown in Figure 13.

Figure 12: NIHTS GUI Calibra-
tions Tab. Here you can run
the Arcs Sequences and Flats Se-
quences for desired slit widths.

3.2 Dome Flats

1. Once the arcs script is complete, you will need to ask the operator to setup for Dome Darks.
The telescope operator will need to open the the mirror cover and instrument cover. At this
point, the dichroic should still be in place and all flat lamps should be off. Ask the telescope
operator to slew to the Dome Flat Screen.

2. Select the desired slit widths for observations in the bottom panel of this tab (Tsb 2; Fig-
ure 12). If you are unsure which slits you will be observing with, you can collect calibrations
for all slits. This will take about 15 minutes total for Dome Darks and Dome Flats.
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Figure 13: Five co-added arc lamp
exposures at 120-sec each. Back-
ground subtraction from a 120-sec
image without the lamps on has
been applied. Faint lines are de-
tectable to ∼2 µm. On sky obser-
vations of planetary nubulae have
provided an extended wavelength
calibration out to 2.166 µm. This
spectrum was taken with the 1.34
arcsec slit on 2017-12-18.

3. In the Calibrations Tab, click [DOME DARKS] to begin the Dome Darks Sequence.

(a) This script takes 1 exposure for each slit width while the Flat Lamps are OFF. These
exposure times are listed below in Table 1.

4. Once this sequence is complete, ask the telescope operator to turn on the Deveny Flat Lamps
to an intensity of 6V.

5. Then, click [DOME FLATS] to begin the Dome Flats Sequence.

(a) The Dome Flats script will take 10 exposures for each slit width with the Flat Lamps
ON. Example flat field spectra for each slit are shown in Figure 14. Exposure times
for these flats were chosen to produce sufficient counts across the spectrum without
saturating due to thermal background at long wavelengths.

Slit # Slit Width (′′) Exposure Time (s)

1 4.03 1
2 1.34 3
3 0.81 6
4 0.27 15
5 0.54 7
6 1.07 4
7 1.61 2
8 4.03 1

Table 1: Deveny 6V Lamp Dome Flat exposure times for each slitlet.

4 Observing Procedure

4.1 Observing Logs

Many astronomers like to take logs as a backup to image header information. We have created a
NIHTS Observing Log (pdf) which you can locate on the dct-obs1 (or dct-obs2) desktop available
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Figure 14: Slice along the disper-
sion axis of flat field exposures for
each slit. Exposure times have
been set to achieve peak counts
∼6000 - 8000.

for printing. There is currently one version of the log, but in the near future, two versions of the
log will be available - one for NIHTS only observing, and the second for simultaneous NIHTS-LMI
observing. See Appendex D.

4.2 Wavefront Solution

The wavefront solution will remove any higher order aberrations associated with the primary mir-
ror. Normally, the wavefront solutions take between 10-15 minutes. The wavefront should be
accomplished when the temperatures have stabilized and when the sky has darkened enough (a
little while after twilight). In order to achieve a valid wavefront solution, the seeing should be less
than 1.5′′. Finally, if there is a large temperature swing of around 5 degrees, you should consider
refocusing as well as redoing the wavefront.

If you plan to guide during observations, this is a good time to let your operator know so that
they can appropriately set the probe.

4.3 Focus Sequence

1. Ask the telescope operator to point to a nominal NIHTS focus star (J=12-13) from the
UCAC4 catalogue by referencing the 2MASS magnitudes.

2. Acquire the star by creating a background subtracted image. In the NIHTS GUI Focus Tab
(Tab 3; Figure 15), click [Take Exposure] to capture a 3-second exposure in the slit viewing
camera of the focus star. Then, in the ZTV GUI Source Tab (Figure 10), set this image to
be the background image by clicking [Make Current Image the Sky Frame].

3. Select the ZTV NIHTS Tab (Figure 16) and use the hand paddle to offset 10′′ Up or Down.
Take another exposure in the Focus Tab of the NIHTS GUI. You should now see the focus
star very clearly in the ZTV display.

4. Select the ZTV Phot Tab (Figure 17). Then, change the cursor mode by right-clicking in
the image display with your mouse and selecting “Phot” from the pull- down menu. Click
on the focus star. You will see a Gaussian profile fit in the ZTV PHOT window where the
blue annulus surrounds the focus star and the red annulus defines the background. You want
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a focus star with ∼4000-8000 peak counts in this three second exposure. You can use the
FWHM (pix) to estimate the current seeing (plate scale = 0.32′′).

Figure 15: NIHTS GUI Focus
Tab. Once you have located a fo-
cus star in the slit viewing cam-
era with the ZTV GUI, you can
setup for a focus sequence by en-
tering the appropriate information
to begin the focus sequence.

Figure 16: ZTV GUI NIHTS Tab

Figure 17: ZTV GUI PHOT Tab

5. Set the focus script inputs into the appropriate fields in the NIHTS Focus Tab.

(a) Note the x, y centroid position of the focus star in the ZTV GUI Phot Tab.

(b) Enter the integer values into the X Pos and Y Pos fields in the NIHTS Focus Tab.

(c) Specify the LMI filter only if planning to use LMI and NIHTS simultaneously. The
default position of the NIHTS dichroic corresponds to the SDSS g filter on LMI. If
using LMI simultaneously, make sure the LMI filter wheel is currently set to the desired
filter specified in the NIHTS GUI. Note that each LMI filter requires a different dichroic
position to keep both LMI and NIHTS in focus. These values are listed in Table 2 below.

(d) Set the step size to 20 or 50 microns to begin, depending on how close to best focus you
think you are with your initial FWHM. If you need to repeat the focus sequence for any
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reason, you can either increase this for larger sampling, or decrease to refine the best
focus. The minimum focus step is 20 microns. You can also set the best guess focus
value (currently at 700) in the Focus Offset Box.

6. Click the [FOCUS] button to begin the focus sequence.

7. The Focus script will take two exposures at each focus offset, 3 step sizes below the best guess
focus, and 3 step sizes above. The script will pull out 30′′× 30′′ thumbnails around the focus
star and fit Gaussian profiles in both the x and y directions.

8. The focus curve plot (Figure 18) will display on the screen when the sequence is complete.
The best focus will be the intersection of the two curves where the star is the most ‘round’.
The terminal will print out best focus offset, best seeing, and estimated seeing variability.

9. Finally, a pop-up window will ask if you want to accept the best focus calculated from the
focus curve. If you click [YES], the script will send the best focus. If you click [NO], the
script will send you back to the best guess focus offset that was indicated in the box on the
NIHTS GUI. If you want to send a different focus offset, you can do this by entering a value
into the [Focus] box on the ZTV GUI in the NIHTS Tab and hitting the return button on
your keyboard to send the value.

Figure 18: Focus Curve. The in-
tersection of the fits in the x (blue)
and y (red) directions will give the
fitted best focus offset.

4.4 Moving the Telescope

There are currently two ways for the astronomer to move the telescope into position:

1. Give the operator your coordinates (either on paper or by shouting across the room).

2. Construct a simple text file ahead of time and load it into the Target Observing List Tool
(opened from the icon on the dct-obs1 (or dct-obs2) Desktop) in order to select coordinates
to send to the telescope. This process is detailed in Appendix F.

3. Edit one item at a time manually into the Target Observing List Tool.

*Note: If using Ephemeris files please make sure to send either the target names or the Horizons
ID’s to your telescope operator prior to the start of observing so they can create the files. The
default time step for the Horizons Ephemeris files is 2 minutes however if you want something
different, simply let the telescope operator know.
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LMI Filter Focus Offset (µm) Dichroic Position (mm)

Miscellaneous Filters
Open 0 239.95
VR +185 237.84
Johnson-Cousins Filters

B +105 238.76
V +105 238.76
R +140 238.36
Sloan (SDSS) Filters

g′ +180 237.90
r′ +180 237.90
i′ +180 237.90
Narrow Band Filters

[OIII] +205 237.62
Hα-On +155 238.19
Hα-Off +155 238.19
Wolf-Rayet Filters

WC +165 238.07
WN +160 238.13
CT +170 238.01
Comet Filters

Blue Continuum (BC) +175 237.96
Green Continuum (GC) +175 237.96
Red Continuum (RC) +175 237.96

Table 2: Focus offset and dichroic positions for LMI filters which can be used simultaneously with
NIHTS. Note the nominal focus value for the Open filter is 810 microns. See Section 8.1 for the
dichroic transmission curves.

4.5 On Sky Calibrations

We recommend a Arcs Short sequence at each pointing location to accurately fit the elevation
dependence of the dispersion solution. In the NIHTS GUI under the Calibrations Tab, there is a
[ARCS SHORT] button which runs a short arcs sequence. The script takes less than 2 minutes
to run. The Arcs Short sequence takes three 20 sec exposures with the Xenon lamps ON and
one 20 sec exposure with the Xenon lamps OFF. The short sequence allows us to fit the bright-
est of the arc lines and apply the corresponding elevation-dependent shift to the dispersion solution.

Procedure:

1. Move to the telescope to your science or calibration target.

2. Ask the telescope operator to close the instrument cover.

3. Click the [ARCS SHORT] button in the Calibrations Tab of the NIHTS GUI.

4. Once the sequence is complete, ask the telescope operator to open the instrument cover.

5. You can now proceed to collecting science data.
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4.6 Target Acquisition

** IMPORTANT NOTE ** The ZTV GUI and the NIHTS GUI are run through separate
python environments and do NOT communicate with one another. As a result, we do not recom-
mend moving to slitlets from Home using the ZTV GUI. The scripts handle the separate python
environments, but if you are doing the moves by hand, this can get messy very quickly.

1. Take a test exposure on the Slit Viewing Camera from the NIHTS GUI XCAM Tab (Tab 4;
Figure 19)

(a) Set the Exposure Time and # Coadds fields then click [XCAM] to take an exposure.
The recommended max exposure time is 5 seconds. The display will be shown in the
ZTV GUI.

Figure 19: NIHTS GUI XCAM
Tab. This tab allows you to set
the slit viewing camera exposure
information and move your target
onto the desired slit.

2. You need to Home your target in the slit viewing camera by using the [Click to Home] button
in the ZTV GUI NIHTS Tab (Figure 16). Click the [Click to Home] button then click on
your target. This moves the target to the Home location. (You can [Click to Home] multiple
times for better accuracy because there is currently no centroiding feature.)

3. Take an exposure in the NIHTS GUI XCAM Tab to confirm the location of your target is
actually at Home, defined as the center of the chip (160,128). Once at home, in the NIHTS
GUI XCAM Tab, click [Target is at HOME].

Now both interfaces (ZTV and NIHTS) know that the target is at Home and you can send
offsets to move your object to the desired slit position.

**IMPORTANT NOTE** The Home location is critical. All slit positions are defined
relative to this Home location. If you forget to send your target to Home before trying to
access a slit location, then the pointing will not be where you expect. The Home location
needs to be set separately in ZTV and NIHTS.

4. If you would like to guide, ask the telescope operator to setup guiding. Once guiding is
running you may want to confirm on ZTV that object is still at Home.

5. Move the target to the desired slit and position (A or Center) using the [MOVE] button in
the NIHTS GUI XCAM Tab. Select the appropriate Slit and Position, then click [MOVE].

6. Confirm the target has moved to the correct position by taking a slit viewing camera exposure
with the [XCAM] button. Note that the A/B positions are shown as hatch marks on each
slit outline on the ZTV display.
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4.7 LMI Acquisition

For targets with V 18 or fainter, we recommend a target acquisition procedure with LMI. Determine
the LMI→NIHTS slit viewing camera pixel mapping using a bright target (V=5-10) at a similar
airmass to the faint target. The mapping can then be applied to the faint target for a blind acquisition
with LMI onto the NIHTS slit.

1. Bright Target (V=5-10):

(a) Move the telescope to the bright target.

(b) Clear any NIHTS offsets by selecting [CLEAR] in the ZTV GUI NIHTS Tab.

(c) Take a 1 second exposure with the slit viewing camera in the NIHTS GUI XCAM Tab.

(d) In the ZTV GUI NIHTS Tab, [Click2Home] then click on the target to send the object
to the HOME position.

(e) Locate the target in the LMI LOUI.

(f) Perform a centroid on the target by typing c on the target in the LMI LOUI display.
Record the X/Y position that is printed to the LOIS Log below the image display.
*NOTE: This X/Y position corresponds to HOME on the NIHTS slit viewing camera
and is where the faint target will need to be placed during blind acquisition.

(g) In the NIHTS GUI under the NIHTS Tab, click [TARGET IS AT HOME], and send the
bright target to the desired slit.

(h) You are now ready to begin collecting spectra of the bright target.

2. Faint Target (V¿18):

(a) Move the telescope to the faint target location.

(b) In the ZTV GUI NIHTS Tab, [CLEAR] offsets.

(c) Take an LMI exposure. Locate the target. Type c to determine the current X/Y location
of the science target on LMI.

(d) Open a new PWRUSB terminal window in the XCAM screenshare by clicking on the
PWRUSB terminal window and typing Command-N.

(e) Use the NIHTS-LMI Mapping Script by typing the following command:
> python NIHTS_LMI_Mapping.py home_x home_y xpos ypos

where home_x home_y is the X/Y location of HOME determined from the bright target
and xpos ypos is the current X/Y location of the faint target on LMI.

(f) The script will print an East and South offset in arcseconds.

(g) In the ZTV GUI NIHTS Tab, enter the offsets into the hand paddle.
Do not apply offsets with LMI.

(h) Take another LMI exposure and confirm that the target has moved to the desired X/Y
Home location on the LMI display.

(i) In the NIHTS GUI NIHTS Tab, click [TARGET IS AT HOME].

(j) Move to the target to the desired slit.

(k) Begin collecting science exposures.
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Figure 20: NIHTS GUI NIHTS
Tab.

4.8 NIHTS Exposures

Collect spectra of your target by collecting single exposures of the spectral channel or executing
nod sequences through the NIHTS GUI NIHTS Tab (Tab 5; Figure 20).

1. Setup the header information in the top panel of the tab by entering the target name, exposure
time, and whether guiding is on or off.

2. There are two ways to take single exposures of the spectral channel:

(a) Test Exposure: Click the [NIHTS Test] button to take a single test exposure with the
desired exposure time. Note that all test exposures are saved as images, however, header
information will be limited to a target name of “test”.

(b) NIHTS Exposure: Click the [NIHTS] button to take a single exposure where target
name, exposure time, and current slit position are all reflected accurately in the header.
Use the [# Seq] box to take multiple NIHTS exposures.

3. There are currently three scripted nod sequences, all of which expect the pointing to begin
with the object on the slit at either the A or Center position. See Section A for more details
on these scripts:

(a) AB Nod: nods the target from the A beam position to B beam position. Set the header
information in the NIHTS GUI NIHTS Tab, including the desired number of sequences,
and click [AB] to begin.

(b) ABBA Nod: takes 1 exposure at the A beam position, 2 at B, and 1 more at A. Set
the header information in the NIHTS GUI NIHTS Tab, including the desired number of
sequences, and click [ABBA] to begin.

(c) Center-Sky Nod: takes 1 exposure at the Center position, dithers the telescope off
slit at a specified distance in arcseconds and direction (RA, DEC, LEFT, RIGHT, UP,
DOWN) and takes another exposure. Set the header information in the NIHTS GUI
NIHTS Tab, including the desired number of sequences, offset distance, offset direction,
and click [CEN-SKY] to begin.

NOTE: While the nod scripts are running, you can make small adjustments to your target
alignment on slit by applying small offsets in the ZTV NIHTS Tab. Monitor this alignment
on the ZTV display.
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4. If you think ZTV and the command line are out of sync, reset both ZTV and NIHTS to
Home as described in Section 4.6 above.

• ZTV: [Click to Home]

• NIHTS: [Target is at HOME]

5. Don’t forget! Clear your offsets before moving to the next target! This can be done in the
Target List, in the ZTV GUI, or by asking the telescope operator.

4.9 Rotator Frame

The telescope can operate in two different rotator modes: Target mode which maintains field
orientation during exposures, and Fixed mode which keeps the focal plane fixed relative to alt-az
coordinates, typically set to the parallactic angle (i.e. perpendicular to the horizon). These modes
are set by the telescope operator and need to be specified when setting up on a target. Confirm
the current rotation angle by referencing the ‘ROTIPA’ keyword in the Facility Summary.

• Target Mode: With the rotatorFrame=“Target”, the default angle of 0◦ results in the
NIHTS slit viewing camera oriented with N to the right and E up (LMI orientation will be
N up, E left). Setting the rotator PA to 30◦ will change this orientation by 30◦ from north
through east. We recommend you use Target Mode for situations when you are observing at
low airmasses (roughly <1.5). The telescope can more easily keep your target fixed on the
slit.

• Fixed Mode: In rotatorFrame=“Fixed” mode, the rotator PA is the mechanical angle of
the instrument cube and stays constant relative to the horizon. We recommend you use Fixed
Mode when you are at high airmass (roughly >1.5). As you move to lower airmass, it can be
difficult to keep your target on the slit in Fixed mode.

4.10 Telescope Offsets

The telescope control supports both relative and absolute offsets (described below). These can
be applied in a number of ways including through the ZTV and by the telescope operator. It is
important to note that the NIHTS and ZTV control interfaces do not necessarily communicate
with one another, which can lead to confusion regarding the current pointing state of the telescope.
The best way to recover from this is to zero the pointing by clearing the offsets and reacquire the
target.

• Relative: These offsets can be applied in the ZTV GUI using the hand paddle in the NIHTS
Tab and are applied relative to the current pointing location. These offsets can be repeatedly
applied to accumulate net offsets relative to a reference zero point, often the original target
pointing. In the ZTV NIHTS Tab, pressing the [Clear] button will return the telescope to its
reference zero point position. The [Absorb] button will define a new zero point at the current
pointing. Any cumulative offsets you have applied will continue to be applied to every new
pointing until explicitly cleared by hitting [Clear].

• Absolute: These offsets are currently only available to the telescope operator. Absolute
offsets are applied relative to the pointing zero point. Repeatedly applying the same absolute
offsets will not move the telescope. Whatever you have applied here will continue to be
applied to every new pointing until explicitly cleared by hitting [Clear] in ZTV. To reset the
pointing zero point to the current location, use the [Absorb] button in ZTV.
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4.11 Real Time Image Analysis

Real time image analysis tools for the NIHTS spectral channel images (i.e. in the LOUI, not in ZTV)
include image differencing, pixel dump, single column/row line profiles, and averaged column/row
line cuts. There are four image display options: Current, Previous, Reference, and Diff. The
Reference image is selected using the NIHTS menu on the image viewer toolbar. The difference
image (Diff) is created by subtracting the reference image from the currently selected image –
Current, Previous or Reference. For example, if the Current image is displayed, then clicking Diff
will display Current - Reference. Image analysis can be performed on any of the images.

• Pixel Dump: This displays a text version of the pixel counts in a 9x9 region in the Pixel
Dump Tab. This function is toggled on and off by placing the cursor in the image, and typing
p. But, be warned: these are “sampled” values because of the under-sampling that LOUI
does for image display, so the peak intensity of a star may not be correct, and similarly a bad
column or other defect may escape notice. An example of the Pixel Dump Tab is shown in
Figure 21.

Figure 21: Pixel Dump

• Line Profile: The Line Profile tool allows the user to make line and column plots: typing l

in the image display will display just the region that spans the image view, while an L will
provide line and column plots of the whole image. An example of the Line Profile Tab is
shown in Figure 22. Typing l or L a second time will turn the Line Profile tool off. Before
switching images for analysis, you must turn the tool off. Once the new image is displayed,
you are then able to turn the tool back on by typing l or L.

• Line Cut: This feature allows you to create horizontal and vertical cuts by drawing a rectangle
around a region of interest. The Horizontal Line Cut averages the rows in the box, while the
Vertical Line Cut averages the columns. The vertical cut is useful to monitor the current
seeing, as the tool will fit a 1-D Gaussian profile to the average across the columns.

5 End of the Night

1. dct-obs1 (or dct-obs2):

(a) If you used LMI, HOME the filter wheel.

(b) Exit out of the NIHTS (and LMI) LOUI by clicking the red [X] in the upper left corner.

(c) Do NOT [Exit LOIS].

(d) Do NOT close the obsnihts@nihts terminal window.
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Figure 22: Line Profile

2. Mac Mini:

(a) Exit ZTV, NIHTS, and the corresponding terminal windows.

(b) In the white terminal window (“PWR USB”) located in the top right corner of the Mac
Mini screen share (Figure 23 below), turn off the slit viewing camera by typing the
command:
> python NIHTS_shutdown.py

Leave this terminal window open.

(c) Close Mac Mini Screen Sharing Window.

3. Fill out the End of Night Report found on the dct-obs1 (or dct-obs2) Desktop.

Figure 23: PWRUSB Terminal
Window

6 Taking Your Data Home

dct-obs1 (or dct-obs2):

• NIHTS: /nihts/YYYYMMDDa (or b or c or ...)

• LMI: /LMI/YYYYMMDDa (or b or c or ...)

MacMini:

• XCAM: /Users/user/xcam/xenics-data/YYYY-MM-DD
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7 Important Tips and Troubleshooting

1. ZTV can be closed and restarted without problems.
In the Terminal Menu, Terminal→New Window→ ZTV.

2. The NIHTS GUI (XCAM terminal) can be closed and restarted without problems (Note:
there are some exceptions to this).
In the Terminal Menu, Terminal→New Window→ XCAM.

3. Every time you restart the NIHTS GUI, you must take a Test Image from the NIHTS GUI
Test Image Tab (See Section 2d).

4. Starting before UT turnover in ZTV requires you to restart ZTV because the date directory
changes at turnover. You will need to take a NIHTS Test Image at restart. See Section 2.
Terminal→New Window→ ZTV.

5. If a nod script fails partway through but the GUI environment is still active, then you will
need to re-Home your target in ZTV and NIHTS. See Section 4.6. If the failed script quits
the NIHTS GUI, you need to restart the NIHTS GUI.
In the Terminal Menu, Terminal→New Window→ XCAM.

6. The two environments ZTV and NIHTS can get confused and have different values for the
current telescope pointing. Correct this by sending the target to Home in the ZTV window and
forcing the current target point to equal Home in NIHTS by clicking [Target is at HOME].
See Section 4.6.

7. After an Arcs Sequence, if you get an image of zero value (i.e. they show up all black with
no data in them) and a PWRUSB error in the XCAM terminal window, click the [Open
Camera] button in the NIHTS GUI Test Image Tab. If this does not resolve the issue, restart
the NIHTS GUI.
Terminal→New Window→ XCAM.

8. If you get images of zero value with no PWRUSB error, you will need to restart LOIS and
re-initialize the LOUI. This is a symptom of an instrument controller crash (instrument LEDs
are in a two-light state) which requires reestablishing connection with the instrument through
a LOIS restart. LOIS can be restarted by restarting the LOUI. See Section 2.

9. If you see the error “missing tcsStatus and/or tcsTelemetry or unable to figure out posang,
so no move sent”, try to resend your target. Otherwise, check the broker status.
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8 Instrument Overview

The Near-Infrared High-Throughput Spectrograph (NIHTS, pronounced “nights”) is a low-resolution
(R∼200) near-infrared prism spectrograph, covering 0.86-2.4 microns in a single order. NIHTS con-
tains no moving parts and employs a single slit mask with 7 different slit widths (4.03, 1.34, 0.81,
0.27, 0.54, 1.07 and 1.61 arcseconds), each approximately 12 arcseconds in length. An instrument
schematic is shown in Figure 24 where light enters from the telescope on the lower right, is redi-
rected twice off of an Offner relay, passes through the slit mask, out to a large fold mirror and a
ZnSe prism, and then back through the fold mirror to be imaged onto a HAWAII-1 array. The
entire assembly is chilled with two Sunpower closed-cycle Stirling cryocoolers. NIHTS is fed by a
dichroic at the center of the instrument cube (Figure 25) which enables simultaneous LMI imaging
and NIHTS spectroscopy.

Figure 24: NIHTS Layout

8.1 Dichroic Mirror

The NIHTS dichroic sits in the Fold Mirror D location in the instrument cube. The dichroic
transmits visible wavelengths and reflects the near-infrared, allowing for simultaneous observing
with LMI and NIHTS. The visible wavelength transmission of the dichroic is about 90% between 0.4
and 0.7 microns. The LMI filters with transmission profiles that overlap the dichroic transmission
are given in Table 2.

8.2 LMI Field of View

The full LMI field of view is reduced during simultaneous NIHTS/LMI observing due to obstruction
by the dichroic. Changing the LMI filter automatically causes offsets of the secondary mirror to
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Figure 25: NIHTS lightpath through the instrument cube with the dichroic for simultaneous LMI
and NIHTS observing.

accommodate for filter-dependent focus. The dichroic has to be offset to compensate for this change
in light path to keep NIHTS in focus. As a result the unobstructed region on LMI will shift with
these dichroic offsets. Figure 27 is an LMI flat in SDSS r with the NIHTS dichroic inserted into
the light path. The dichroic was inserted to full extension (242.1 mm) and then retracted 4.2 mm
(237.9 mm) to achieve focus on NIHTS. The central region in grey is roughly 6×4 arcmin in size and
throughput drops off steeply outside of that region. Table 2 provides computed dichroic positions
for each filter.

8.3 Slit Mask

The slit mask contains a single slit broken up into 7 different slit widths – referred to as slitlets –
in a configuration with the widest slitlets near the edge of the mask, and the narrowest slitlets in
the middle. Each slitlet is 12′′ long. The slit widths from left to right in the slit viewing camera
(top to bottom on the spectrographic detector) are 4.03′′, 1.34′′, 0.81′′, 0.27′′, 0.54′′, 1.07′′, 1.61′′,
and 4.03′′. Figure 28 shows a cartoon schematic of what is visible on the slit viewing camera.
The two widest slits (4.03′′) are referred to as SED1 and SED2 where SED stands for spectral
energy distribution. These slits are designed to eliminate slit losses to enable spectro-photometric
calibration. The approximate pixel locations of each slit on the slit viewing camera are detailed
in Table 3. The pixel location of the narrowest slitlet (0.27′′) is not well constrained. There are
other factors, including the location of the amplifier boundaries on the spectral channel, that make
the 0.27′′ slitlet difficult to use. As such, we do not recommend the use of this slitlet at this time.
The measured per pixel resolution and resolving power of each slitlet at 1, 1.5, and 2 microns are
defined in Table 4.
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Figure 26: Dichroic transmission through to LMI and reflectance to NIHTS. The spectral range of
NIHTS is shown. These curves are roughly constant longwords of 1.0 micron out to 2.4 microns.
The transmission through to LMI spans wavelengths that overlap Johnson-Cousins BVR and SDSS
g and r filters.

Slit # Slit Width (′′) Y Center A Position B Position Center

1 4.03 122 15.3 30.7 23
2 1.34 117.8 49.8 65.2 57.5
3 0.81 116.9 87.8 103.2 95.5
4 0.27 114.3 125.2 140.7 133
5 0.54 115.1 162.8 178.2 170.5
6 1.07 116.9 198.3 213.7 206
7 1.61 116.8 234.3 249.7 242
8 4.03 122 273.3 288.7 281

Table 3: Slit Positions on the Slit Viewing Camera

8.4 Coadds

Currently NIHTS only supports coadds on the slit viewing camera. NIHTS does not support coadds
at the time of data acquisition on the spectral channel. The observer can coadd by stacking spectral
images post-observing.
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Figure 27: Observable field of
view on LMI with dichroic de-
ployed. The unobstructed field
size is 6.4′×4.1′. The green con-
tours are at 500 ADU intervals be-
tween 15,000 and 25,000 counts.
Image courtesy of Stephen Levine
(Lowell).

0.27”sed1 sed20.54”0.81” 1.07”1.34” 1.61”

Figure 28: Schematic of the
NIHTS slit mask with 8 slitlets of
7 different widths, each 12′′ long.

Slit # Slit Width (′′) R=λ/δλ (per pix) R′ = R/slit width
1µm 1.5µm 2µm 1µm 1.5µm 2µm

1 4.03 2125 675 546 69 22 18
2 1.34 2194 667 535 196 60 48
3 0.81 1813 680 525 271 101 78
4 0.27 1283 682 502 583 310 228
5 0.54 2087 663 521 464 147 116
6 1.07 2152 667 531 242 75 60
7 1.61 2311 645 513 172 48 38
8 4.03 2113 680 548 68 22 18

Table 4: Measured resolution per pixel and effective resolving power of each slit at three reference
wavelengths.
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8.5 Detector Linearity and Saturation

To first order, the NIHTS detector is linear up to about 17,500 counts in all wavelengths (Figure 29).
The detector saturates earlier in the longer wavelengths. We will be performing a more detailed
pixel by pixel linearity mapping. Coming soon...

Table 5 below shows the maximum wavelength reached prior to saturation in each of the slits
with respect to a given exposure time. The NIHTS detector is sensitive up to 2.45 µm.

Figure 29: Linearity test with in-
creasing exposure time vs counts
at 0.97 µm, 1.62 µm, and 2.46 µm.

Slit (′′) sed1 1.34 0.81 0.27 0.54 1.07 1.61 sed2

ExpTime (s)
3 2.45 2.45 2.45 2.45 2.45 2.45 2.45 2.45
4 2.40 2.45 2.45 2.45 2.45 2.45 2.45 2.40
5 2.35 2.45 2.45 2.45 2.45 2.45 2.45 2.35
10 2.30 2.45 2.45 2.45 2.45 2.45 2.40 2.30
20 2.20 2.30 2.45 2.45 2.45 2.40 2.30 2.20
30 2.20 2.30 2.35 2.45 2.35 2.30 2.25 2.20
45 2.15 2.25 2.30 2.30 2.30 2.30 2.20 2.15

Table 5: Maximum accessible wavelength (in microns) for a given slit and exposure time. NIHTS
is sensitive to a maximum wavelength of 2.45 µm. Note that the wider slits saturate in the longer
wavelengths at much shorter exposure times than the smaller slits as a result of thermal background.

8.6 Dispersion Stability

We have quantified the dispersion stability in Y, J, and H bands up to ∼ 2 µm. Figure 30 shows sub-
pixel stability at all elevations. We recommend that for most science cases, a full arcs calibration
at zenith at the beginning of the night and short arc calibration sequences (< 2 min) at each target
pointing throughout the night will be sufficient for determining the dispersion solution.
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Figure 30: Wavelength shift (∆λ)
of arc lines up to 2 µm with eleva-
tion changes from 0◦ to 90◦. We
see ∼1 pixel shift across the eleva-
tion range.

8.7 NIHTS Efficiency

We determined the sensitivity of the NIHTS detector using spectrophotometric standard star Feige
110, observed through the SED1 (4.03′′) slitlet. The results for the total flux measurements are
outlined in Table 6. These data were used to derive the overall system throughput which is plotted
as efficiency curves in Figure 31.

Integrated Counts
Band λ Mag. Catalog Flux # pixels Object Sky S/N Mean Eff.

(µm) (erg/s/cm2/Å) (s−1) (s−1) (%)

Yish 0.96 - 1.1 12.94 1.32×10−12 3640 29900 29500 44.8
J 1.1 - 1.4 12.55 2.54×10−13 2400 23000 36000 45.3
H 1.5 - 1.8 12.63 7.33×10−14 1140 16500 81000 36.5
K 2.0 - 2.4 12.77 2.18×10−14 970 10700 560000 30.4

Table 6: Measured counts integrated over different band passes for spectro-photometric standard
star Feige 110. The resulting mean efficiency of the instrument and telescope is given in the last
column.

Figure 31: Measured NIHTS ef-
ficiency which accounts for tele-
scope, dichroic, and detector
throughput in Y, J, H, and K
bands. Regions of telluric absorp-
tion, which can have highly vari-
able transmission, have been ex-
cluded.
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A NIHTS Scripts

The NIHTS Scripts are executed through the NIHTS GUI to operate the spectral channel and slit
viewing camera through python based commands.

• ARCS LONG

– Description: Take a full arc lamp calibration sequence.

– Turns on the Xenon Arc lamp. Takes 5 exposures at 120-sec and 3 exposures at 20-sec.
Turns the Xenon Arc lamp off. Takes 1 exposure at 120-sec and 1 exposure at 20-sec to
capture the thermal profile for each exposure time.

• ARCS SHORT

– Description: Take a short arc lamp calibration sequence.

– Turns on the Xenon Arc lamp. Takes 3 exposures at 20-sec. Turns the Xenon Arc lamp
off. Takes 1 exposure at 20-sec to capture the thermal profile.

• DOME DARKS

– Description: Take a sequence of dome dark exposures for the specified slits.

– Takes 1 exposure for each of the requested slits at their slit-defined exposure time with
flat lamps off to account for the thermal profile.

• DOME FLATS

– Description: Take a sequence of flat field exposures for each of the requested slits.

– Takes 10 exposures for each of the requested slits at their slit-defined exposure times
with the Deveny 6V flat lamps on.

• FOCUS

– Description: Take a focus sequence with the slit viewing camera.

– Move to a nominal NIHTS focus target of J=12-13. Note the x,y position of the star
in ZTV, as you will need that in the script. If you are not using LMI, the LMI filter
entry value in the script will be OPEN. Note that each LMI filter will require a different
NIHTS dichroic position. The script handles this by prompting you to move the dichroic
to a given location depending on the LMI filter you request. The script will take a total
of 7 different focus steps with 2 exposures taken at each step. The images are copied
to a folder entitled focus 0 (focus 1, focus 2, etc). 30′′ × 30′′ thumbnails are extracted
around the star for each image. Gaussian fits are performed in both x and y directions.
The FWHM of each fit is calculated and plotted against focus values for the final fits.
The best focus for x and y are printed to the terminal screen. Once a focus is found in
one LMI filter, you should be able to switch between filters and remain in focus, as long
as you move the dichroic accordingly.
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• NIHTS

– Description: Takes NIHTS science exposures.

– Begin by placing the target at the desired slit position. Click NIHTS to begin collecting
science exposures. Use the [# Seq] box in the GUI to identify the number of exposures
to collect. At any time, you can apply a small offset in the ZTV GUI to nudge your
target back onto the center of the slit.

• AB NOD

– Description: Two-exposure sequence with target nodded between A and B slit positions.

– Begin by placing your target in the A position of your desired slit in ZTV. The script
will take one exposure at the A position. It will nod the telescope to the B position
and take one exposure. You can monitor your target’s position on the slit with the slit
viewing camera in ZTV. At any time, you can apply a small offset in the ZTV GUI to
nudge your target back onto the center of the slit. The number of sequences is defined
in the [# Seq] box in the GUI.

• ABBA NOD

– Description: Four-exposure sequence with target nodded between A and B slit positions.

– Begin by placing your target in the A position of your desired slit in ZTV. The script
will take one exposure at the A position. It will nod the telescope to the B position and
take two exposures. It will then nod back to A and take an exposure. The sequence
of ABBA nods repeats for the number of sequences requested. You can monitor your
target’s position on the slit with the slit viewing camera in ZTV. At any time, you can
apply a small offset in the ZTV GUI to nudge your target back onto the center of the slit.
This is extremely helpful if you are taking many sequences and your target is drifting
slowly off slit.

• CEN-SKY NOD

– Description: Exposure sequence with target nodded between slit center and off-slit po-
sitions.

– Begin by placing your target in the Center position of your desired slit in ZTV. The
script will take one exposure at the Center position. It will nod the telescope to the
desired offset position requested in the command and take one exposure. The sequence
of CEN-SKY nods repeats for the number of sequences requested. You can monitor your
target’s position on the slit with the slit viewing camera in ZTV. At any time, you can
apply a small offset in the ZTV GUI to nudge your target back onto the center of the
slit.

*Note: If there are scripts you need but don’t see available, contact Nicholas Moskovitz and
Annika Gustafsson at nmosko@lowell.edu and agustafsson@lowell.edu.
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B Troubleshooting iPython XCAM Commands

> x.go(exptime_sec=None, coadds=None, nexp=None, return_images=False

save_every_Nth_to_currentfits=None)

> nihts.go(nexp=None, exptime=None, target=None, frame_type=None,

comment1=‘Slit: None, Position: None’, comment2=None, aborterror=False)

> tcs.absorb_target_offset

> tcs.clear_target_offset

> tcs.current_target_pt

> tcs.home_pt

> tcs.move_object_on_xcam(start_pt, end_pt, reset_current_target_pt=True)

> tcs.move_to_slit_position(tcs.slit[‘slit_width’][‘A/B/Cen’])

> tcs.send_focus_microns(focus_value_microns)

> tcs.target_offset(ra, dec, handset=False, simple=False, tplane=False)

C PwrUSB

PwrUSB strip on NIHTS has 4 outlets. Three are controlled (numbered 1,2,3). The fourth outlet
is always on.

• Outlet 1: XCAM Camera (turn on at the beginning of the night)

• Outlet 2: NIHTS Camera (always on)

• Outlet 3: Xenon Lamps (turn on for arcs sequence)

PwrUSB is controlled from the command line with the command pwrusb.

With no input parameters pwrusb provides documentation on itself. Examples:

> pwrusb status

returns the current outlet states, in format: outlet states on bank BANK:
OUTLET1 OUTLET2 OUTLET3

where OUTLET state is 0=OFF, 1=ON

> pwrusb set OUTLET1STATE OUTLET2STATE OUTLET3STATE

sets all 3 outlets to individually specified states where OUTLET[1-3]STATE— is 0=OFF, 1=ON
(anything except 0 is ON)

> pwrusb setall STATE

sets all 3 outlets where STATE is 0=OFF, 1=ON (anything except 0 is ON)

> pwrusb setone OUTLETNUM STATE

where OUTLETNUM is 1, 2, or 3 and STATE is 0=OFF, 1=ON (anything except 0 is ON)

> pwrusb current

returns the total current being drawn (milliamp)
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D Observing Logs
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E Detailed Focus Procedure

This section describes the detailed process of focusing both NIHTS and LMI while confirming the
expected M2 focus offset between these instruments. This procedure would not generally need to
be run by the observer.

1. Move the NIHTS dichroic fold mirror stage to the fully deployed position.

2. Move the LMI filter wheel to the desired filter in the LMI LOUI.

3. Acquire the nominal NIHTS focus target (J=12-13) on the NIHTS slit viewing camera.

4. Focus on the NIHTS slit viewing camera per the usual focusing procedure.

5. Offset the M2 piston +370 microns from NIHTS M2 position determined in (3). If this or
another offset is known to be correct, skip to step 6.

6. Acquire nominal LMI focus star on LMI. Offset telescope to place object near the center of
the dichroic FOV, at pixel (1055, 950) for images binned 3x3.

7. Focus on LMI per standard procedure with the dichroic in position. Record final M2 position.

8. Calculate back-focus change:

dBF mm = 11.4 ∗ [M2-piston(LMI+dichroic) - M2-piston(NIHTS)] mm

If LMI/dichroic focus was not redetermined in (4-5),

dBF = 11.4 ∗ 0.370 mm = 4.22 mm

9. Read current position of fold mirror D

FM-D-pos mm

Calculate:
FM-D-NIH-pos mm = FM-D-pos - dBF

Enter result in FM-D Move field, and execute.

10. Offset telescope to reacquire target on NIHTS slit viewing camera. The offset should be along
the NIHTS slit spatial direction, approximately:

dA (′′) = dBF (mm) ∗ 8 (′′/mm)

11. Verify image quality on NIHTS slit viewing camera.
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F Observer Target List

There is an astronomer-friendly interface that allows one to construct an observing list and send
the object coordinates to the operator. Full details can be found at http://jumar.lowell.edu/

confluence/display/DCTIC/Observer+Target+List. A simple example is shown in Fig. 32.

Figure 32: Observer Target List text file format

The possible fields for inclusion are:

• title: This needs to be surrounded by double quotes and will be sent to the TCS as the
science target name. The quotes have to be standard ASCII double quotes, they cannot be
the dynamic paired double quotes used by word processors. You either need to use a simple
text editor, or set your editor to not use matching quotes. It cannot be blank. REQUIRED.

• ra: The J2000 right ascension in hh:mm:ss.sss format. The seconds can be either an integer
or a floating-point number. REQUIRED.

• dec: The J2000 declination in in +/-dd:mm:ss.ss format. The seconds can be either an
integer or a floating-point number. The “+” is option. REQUIRED.

• epoch: the epoch for the proper motion. The only allowable value is J2000.0, leaving
epoch=false is probably the best idea.

• muRA: proper motion in RA (mas/yr). Note that this is actually µα × cos δ, which is what
most catalogs (and SIMBAD) provide.

• muDEC: Proper motion in Dec (mas/yr).

• magnitude: Magnitude. The option to include magnitude is in case the observer wishes to
sort the table based on brightness. It is not used by the TCS.

• dRA: non-sidereal tracking rate offset with respect to sidereal in RA in units of arcsecond-
s/hour.

• dDec: non-sidereal tracking rate offset with respect to sidereal in DEC in until of arcsecond-
s/hour.

• rotatorPA: The rotator position angle in degrees. With the rotatorFrame=“Target”, an
angle of 0◦ results in the NIHTS slit viewing camera columns and rows aligned with the
cardinal directions as given in the Fun Facts at the beginning of this guide, i.e., N is to the
right and E is up. Setting the rotator PA to 30◦ will change this orientation by 30◦ from north
through east. In rotatorFrame=“Fixed” mode this angle is instead the mechanical angle of
the rotator, ignoring the sky orientation, and maintains the NIHTS slit perpendicular to the
horizon.

• rotatorFrame: Valid choices are either “Target” or “Fixed,” without the quotes. The former
maintains instrument orientation relative to sky during an exposure (i.e. the instrument cube
rotates to follow the field on sky), the later fixes the instrument orientation relative to the
horizon so that the slit can be fixed at the parallactic angle.
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The fields should all be separated by at least one space. The columns do not have to line up
but extra spaces can be inserted if it makes you happy.

Note: in constructing this file, make sure you use a text editor such as vi or emacs. Do not use
TextEdit, as this doesn’t use the standard ASCII double quote character. It will be helpful if you
give the file the extension “.tls” (for target list), as this is what the program will look for.

To use the tool, do the following:

1. If you’ve brought the file with you on your laptop, sftp it over to observer@dct-obs1 (or
observer@dct-obs2). A convenient place to put it is the desktop, but please be sure to move
the file to the trash at the end of your run.

2. Start the tool by double-clicking the [observerTargetListTool] icon on the desktop.

3. Once started, the “Observer Target List” menu will appear at the upper left on the screen.
Go to File → Open Target List:

4. Open Target List will open a standard dialog box for selecting the input file. The default
extension for the input file is “.tls” (for “target list”) and all other types are greyed out simply
to make it easy to recognize the file among all the other files that might be in a directory.
The input file has to be a standard ASCII text file but it can have any extension (or none at
all). Binary files will not be read correctly.

The open file dialog box allows selection of other file extensions via a drop down menu. The
user can choose “All Files (.)” from the file type drop down menu and that allows selection
of any file in the directory. The files other than *.tls would still be grey but they can be
selected and loaded into the app.

Multiple input files can be used during one session and each file would be loaded into a
separate tab.

5. The process of sending the target to the TCS is a 2 step process. First a target is selected from
the table. The data is loaded into the upper view for a final check by the observer. It can be
sent to the TCS as a science target by pressing the button. Issuing this command can result
in either the telescope moving immediately to the target, or simply loading the target into
the preview pane for the telescope operator’s approval. The behavior can be selected on the
TCS’s UI and cannot be controlled by the observer from the app. The selection is persistent
until changed by the operator. You can check which mode the system is in by looking at the
“External Target Command” label, which will either say “Preview” (the operator checks) or
“Direct” (the telescope just goes there).

Note that we provide several observing lists in the PhotStds folder on the desktop.

• AA2014 ubvri.tls—Astronomical Almanac for 2014 list of UBVI standards (section H),
which is basically the list from Landolt (2009). This is there in case you need it, but most
observers will prefer landolt09.

• clem07—Clem, Vandenberg, & Stetson (2007): Secondary standard stars for the u’g’r’i’z’
photometric system.

• clem13.tls—Clem & Landolt (2013): Faint UBVRI standard star fields

• hbstand.tls—Farnham, Schleicher, & A’Hearn (2000), The HB narrowband comet filters:
standard stars and calibration.
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Figure 33: Observer Target List

• landolt09.tls—Landolt (2009): UBVRI photometric standards around the celestial equator.
This is the preferred list. Finding charts are available locally on dct-obs1 (or dct-obs2) by
going into the landolt09 subdirectory in the PhotStds folder.

• landolt92.tls—Landolt (1992): UBVRI photometric standard stars in the magnitude range
11.5 < V < 16.0 around the celestial equator. This is available if you need it for a particular
reason, but most observers will prefer landolt09.tls.

Figure 34: Some Standard Target Lists are already built in.
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G Data Reduction using SpeXTool

Coming Soon ...
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